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PI SQC is a PI ProcessBook add-in that retrieves data from PI archives and ODBC databases, 
and performs statistical calculations to determine data behavior.  

Results are displayed in a three-part PI SQC chart, which includes one of eight types of 
control charts. The PI SQC chart appears within a standard PI ProcessBook display or 
independent display file. 

 

Statistical Quality Control 

Statistical Quality Control (SQC) has at its heart the experience that all processes fluctuate. 
Fluctuations may be natural or unnatural. Natural fluctuations are generally small, while 
unnatural fluctuations are larger, and are introduced by external and hopefully, identifiable 
causes.  

In simple terms: 

• Everything Varies—People live to different ages; all patterns fluctuate. 

• Individual cases and events are unpredictable—You cannot predict exactly how long 
you will live; individual points are not predictable. 

• Groups within a constant system of causes tend to be predictable—Actuaries can use 
population data to predict life expectancy for insurance companies; a series of points 
from a constant process tend to follow a pattern. 

A series of measurements of a process parameter generally will not be identical to each other. 
However, you can use statistical methods to establish baselines (usually called control limits) 
using data that represent ‘good operating conditions.’ 

Statistically-derived control limits outline the potential behavior of a process, and permit 
differentiation between random fluctuations of data and true process shifts. A control limit 
can be defined by a specific number (center line +/- 3 standard deviations) or in terms of 
pattern tests (4 successive points greater than 1.5 standard deviations from the center line on 
the same side of the center line). 

The primary method of process evaluation is a control chart, a graphic comparison of process 
data versus calculated control limits. You can use a control chart to detect process variations 
that have definable causes by highlighting instances where process data runs outside the 
control limits. 

 

Chapter 1 

Introduction to PI SQC 
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SQC in the Process Industry 

Product specifications typically are market-based, and an actual process is capable of 
performing to tighter tolerances. SQC is one approach to maintaining and improving quality.  

SQC identifies instances of unnatural fluctuation so that causes can be assigned and 
corrected. Control charts are employed by a wide range of industries and agencies as a means 
to monitor and stimulate improvements in many types of processes. 

In many industries, SQC has been applied with large economic benefits. However, 
applications of SQC methods have been limited by the daunting and often tedious tasks of 
calculating samples and plotting data, especially when dealing with very large data sets. 

 

SQC in PI ProcessBook 

PI SQC appears appears as an icon  on the PI ProcessBook toolbar. To add an SQC chart 
object to a ProcessBook display: 

1. In Build mode, click the SQC icon  and drag in the workspace to add the object. 

The PI SQC Chart Definition dialog appears. 

2. Configure chart settings and click OK. 

3. Return to Run Mode. 

As a dynamic object, PI SQC operates like to other dynamic symbols in PI ProcessBook 
displays. When you select an SQC symbol and view the Details window in ProcessBook, you 
see a tabular view of the data used to create the SQC chart.  

For event-based SQC charts based on PI points, you can also create annotations for individual 
event values when Data is selected in the Data Source drop-down list. If sample filtering is 
used in the chart, annotation is disabled for any rows that display the Filtered indicator. 

 

Data Retrieval and Calculation 

Once a PI SQC chart is configured, PI ProcessBook retrieves fresh data whenever you open 
the display containing the chart. The time stamp of a PI tag, a specified number of data 
points, or a change in a Trigger Tag can also trigger a query. Sampling is either time- or 
event-based. 

SQC performs calculations when data is retrieved (including any PI SQC-RT (page 3) 
calculations required remotely), and then updates chart values. The same events occur when 
you modify properties of the SQC calculation or chart, allowing you to instantly view and 
analyze changes. 

If the end time of a PI SQC chart is configured as the current time, PI SQC refreshes the chart 
whenever there is a new chart tag value recorded in PI or ODBC data sources. 
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PI SQC-RT 

PI SQC-RT is a separately-licensed enhancement to the standard PI Alarm Subsystem. PI 
SQC-RT generates SQC Alarm tags, which combine source tag values with the results of real 
time SQC pattern tests performed on the source tag.  

A PI SQC alarm requires five PI tags in addition to the alarm tag itself. These tags provide: 

• a data source for the alarm 

• user control over the operation of the alarm tag 

• storage of control limits  

PI SQC-RT alarms can be plotted and visualized through the PI SQC add-in. See the PI SQC-
RT User Guide for more information. 
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A PI SQC chart includes several components: 

• A control chart on the bottom 

• A histogram (page 8) at top left 

• A legend (page 9) at top right 

• Four sheets of data and statistics (page 9), accessible when you click the chart title 

 

You may configure the control chart, the histogram, and the legend in a variety of ways, and 
any component may be omitted. 

 

Control Chart 

A control chart shows a curve of data markers representing sample values plotted across time: 

• The left axis displays evenly spaced labels in the engineering units of the source tag.  

• The right axis displays control limits. 

• The horizontal axis displays evenly spaced data markers. 

Chapter 2 

PI SQC Chart Components 
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The left and right timestamps on the horizontal axis represent the first and last plot values. 
Each plot point on a control chart is equidistant from preceding and succeeding points, 
regardless of the time span between them.  

If a sample value plots outside of the control limits, an alarm condition occurs and data 
markers appear in different colors and shapes. Data markers are not displayed if they overlap; 
only alarm markers appear.  

A green triangle at lower right indicates the PI SQC chart is being updated in real time. 
 

Control Zones 

Control charts include colored horizontal control zones and a target or center line. The colors 
match the control limits on the right axis and in the histogram (page 8). 

Zones are determined by control limits (page 21) for process evaluation, which may be  
established in several ways: 

• Specified by a user 

• Calculated from actual point values 

• Calculated remotely by a PI SQC-RT Alarm tag 

The zones represent standard SQC classifications: 

Center Zone The area between -1 and +1 Sigma of Center Line. 

One Sigma Zone The area between -2 and -1 Sigma of Center Line and the 
area between +1 and +2 Sigma of Center Line. 

Two Sigma Zone The area between -3 and -2 Sigma of Center Line and the 
area between +2 and +3 Sigma of Center Line. 

Outside 3 Sigma Zone The areas outside control limits. 

Note: For Range, Moving Range, Standard Deviation, and Moving Standard Deviation 
charts, the upper and lower zones may be different in size because the Sigma 
(page 7) values may differ. 

 



 Control Chart 
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Sigma 
Since the target for Range, Moving Range, Standard Deviation, and Moving Standard 
Deviation charts is not always centered on the chart, upper and lower Sigmas may differ.  

Sigma should be interpreted in Range and Standard Deviation charts to mean 1/3 the distance 
between the center line and the upper or lower control limit. For instance, +2 Sigma refers to 
two-thirds of the distance between the center line and the upper control limit. 

The most applicable pattern test for Range and Standard Deviation charts is the 3-Sigma test, 
which indicates data points outside or on the upper or lower control limits. 

Note: The lower control limit in Range and Standard Deviation charts is always zero for 
sample sizes smaller than 7 and 6, respectively. 

 

Alarm Status 

A control chart displays a marker for each data point. If a point is in an alarm condition (page 
23), an alarm marker is substituted. If a data point falls outside of the vertical plot range, its 
marker is displayed at the top or bottom of the control chart. 

PI SQC-RT (page 3) may also be used to configure alarms on the PI Server, and which appear 
in a control chart. A selected data point is in alarm status if it meets a pattern test condition: 

• A green dot  indicates no pattern test conditions have been met. 

• A red exclamation point  indicates a pattern test condition has been met. 

To view alarm tag details in a control chart: 

• Move the mouse over a data point until a magnifier cursor appears, and click on the left 
mouse button. 

The Alarm Details dialog appears. The Alarm Details dialog lists the timestamp, value 
and alarm status of a selected data point.  

Note: The Alarm Details dialog is disabled when trend cursors (page 8) are 
activated. 

If SQC alarms are configured to use the optional test status tag, you can right-click a marker 
in an alarm state to view pass/fail status for all configured pattern tests. If you do not use the 
optional test status point, then only the highest precedence pattern test failure is displayed. 

For information on how to configure PI SQC-RT Alarm tags, refer to the PI SQC RT User 
Manual. 
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Trend Cursors 

In PI ProcessBook Run Mode, trend cursors can be added from the left edge of a control 
chart to read sample values across the chart. Add a second cursor to compare values across a 
range. 

To add trend cursors:  

• Click the Trend Cursor button  on the toolbar to add a cursor to the right edge of the 
chart. 

When released, a trend cursor remains in one spot. Click and drag a cursor to move it to a 
different spot.  

 
 

Histogram 

The histogram component of a PI SQC chart is a bar graph of the frequency distribution of 
plot data. 

 

The horizontal scale spans the Center Line minus five Sigma to the  Center Line plus five 
Sigma. The scale is marked at +3 Sigma and -3 Sigma from the center line. The resulting 
zones are colored using the same colors in the control chart. 

The Mean, Upper and Lower Specification Limits are also indicated in the histogram. 

The number of bars is configurable, and from 1 to 100 bars may be displayed. The vertical 
scale runs from zero to the maximum number of samples per bar. 

A normal distribution curve (page 9) is drawn in the histogram based on the sample mean 
and the standard deviation of the sample. 



 Legend 
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To specify the number of bars or to change the appearance of the histogram, use the Format 
tab (page 25) of the PI SQC Chart Definition dialog. 

 

Distribution and Standard Deviation 

If you specify control limits (page 21), the Sigma that is used in the normal distribution curve 
is calculated by 1/3 the distance between the center line and each control limit. 

You may specify uneven control limits, that is, the distance of the upper control limit from 
the center line may be different from the distance of the lower limit from the center line. In 
such cases, the normal distribution curve reflects Sigma values obtained by: 

 Sigmaupper = (Upper Control Limit - Center Line) / 3 

 Sigmalower = (Center Line - Lower Control Limit) / 3 
 

Legend 

The legend appears at top right in a PI SQC chart, and may display the following 
information: 

Item Description 

Chart tag The name of the tag providing raw data to the chart 

Trigger Tag The name of the tag used to trigger a new sampling (page 16)  

Value The current value of the Chart Tag (page 14) 

Engineering Units Engineering units for the Chart Tag 

USL/LSL Upper and lower specification limits 

Sigma Sigma as used in calculating upper and lower control limits 

Cpk Process Capability Index (page 40), a calculation based on 
specification limits. 

Items that do not have a current value are not displayed. For example, if a user does not 
configure specification limits (page 21), the USL/LSL is not displayed. Calculated items such 
as Cpk or Sigma that do not have a current value will display N/A if they are selected to show 
on the legend.   

To change the appearance of the legend, use the Format tab (page 25) of the PI SQC Chart 
Definition dialog. 

 

Data Sheets 

Four data sheets are available for each PI SQC Chart. To see the data sheets: 

1. Go to Run Mode and double-click the title of the chart. 

The Statistical Quality Control Details dialog appears. 

2. Use the Options menu to select any data sheet. 
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Statistical data are provided in double-precision numbers. Click Save Data to File to save all 
four pages as a text file. 

Statistics Sheet 
Eight statistical values are calculated for control chart plot data each time a PI SQC chart 
updates:  

Statistic Description 

Mean Average value of plot data 

Median Median value of plot data 

Mode Most frequently occurring value of plot data 

STDEV Standard deviation of plot data 

Cpk Calculated Process Capability Index (Cpk (see "Process Capability 
Index (Cpk)" on page 40)), based on specification limits for plot data 

Max Maximum value of plot data 

Min Minimum value of plot data 

Sigma Sigma of the samples as used in upper and lower control limits 

Raw Data Sheet 
The Index column identifies each raw data point plotted for the chart tag, followed by 
Timestamp and point Value. The Status parameter (sometimes called IStat) depends on the 
tag's Point Type in PI. 

Plot Data Sheet 
The Index column identifies plotted data points, followed by Timestamp and Value. 
Following are columns for each control parameter (page 21), which may vary over time.  

The Alarm column indicates whether a data point has triggered an alarm or exceeded 1 Sigma 
from the center line. 

Control Limits Sheet 
Specifications and calculated or specified control limits are listed. 
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The PI SQC Chart Definition dialog is used to define parameters and construct various types 
of SQC charts.  

Note: For calculated tags from PI for Open VMS Server, much of the definition 
functionality is disabled and only Alarm and Format properties can be modified. 

 

Build a PI SQC Chart 

When designing a PI SQC chart, keep in mind that you are simultaneously creating and 
structuring a query to retrieve the desired tag and SQC data. 

If the resulting PI SQC chart is not populated with appropriate data, the query has failed and 
the you may receive a message such as "Event- based query failed" or "Not enough data 
points." Review your selections in the Chart Definition dialog until your PI SQC chart 
appears correctly. 

To build a new PI SQC chart: 

1. Open a ProcessBook display or an independent display file. 

2. Select the PI SQC Chart tool  on the toolbar or choose Draw > SQC Chart.  

The cursor changes to an arrow with a small SQC label. 

3. Click and drag to define the bounding rectangle for the chart within the display.  

Once the bounding rectangle has been defined, the PI SQC Chart Definition dialog 
appears. 

4. Define the chart using the six tabs of the PI SQC Chart Definition dialog (page 11).  
 

Edit a PI SQC Chart 

To modify an existing PI SQC chart: 

• In Build mode, double-click anywhere in the PI SQC Chart to bring up the Chart 
Definition dialog (page 11). 

• In Run mode, click the Item Definition button  to display the Chart Definition 
dialog (page 11). 

 

Chapter 3 

PI SQC Chart Definition Dialog 
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General Tab 

The General tab resembles the PI ProcessBook Trend Definition dialog and is used to specify 
basic chart parameters.  

Chart Title 
Enter a distinctive title for the PI SQC Chart. The default is SQC Plot -1.  

 

Chart Type 

Select the type of control chart you want to display. The name of the chart type is included in 
square brackets after the control chart title. 

Each control chart presents a different view of sample data, and represents different 
mathematical calculations (page 27) based on the type of plot, sample size, and other factors. 

The eight available control charts and their properties are described in the following sections.  
 

Individuals Chart 
An Individuals chart plots raw data from PI or an ODBC dataset, and utilizes single 
observations rather than sample groups to evaluate the stability of the process. 

An Individuals chart is used when it is impractical to calculate the average of a group of 
measurements. Individuals charts are typically used in conjunction with Range or Moving 
Range charts to detect variability.  

In Individuals charts, sample size must be equal to 1, and the center line is the process mean. 
The Moving Range is used to estimate standard deviation when calculating control limits. If a 
PI tag is used as the upper (USL) or lower specification limit (LSL), the control chart displays 
USL and LSL traces. 

Note: Measurements are not independent of one another in an Individuals chart. Pattern 
tests are therefore not applicable, and only the points outside of control limits 
should be considered significant. 

 

X-Bar (Average) Chart 
An X-Bar or Average chart calculates the average of a subgroup of data, and plots it against 
other sample averages. The sample mean is used as the center line unless otherwise specified. 
Individual measurements are assumed to be independent. 

An X-Bar chart indicates where a process is centered, and provides information about the 
quality of process control. Fluctuations that directly affect the X- Bar chart display can be 
construed to affect all parts of the product at once, and in the same general manner. 

Averaging data tends to reduce the effect of random error associated with the variability due 
to measurement and inherent process variation. Averages can be more sensitive in revealing 
changes in process level than individual observations. 
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Moving Average Chart 
A Moving Average chart calculates averages inclusive of each new individual measurement, 
n, and plots them against previous n- 1 averages.  

Moving Average charts have the advantage of being able to detect process shifts and dampen 
out random errors on individual measurements, and are useful when taking more than a single 
observation per sample is impractical. 

In evaluating a Moving Average Chart, consider only whether data is within 3 sigma. Moving 
Average charts should be used in conjunction with the Moving Range chart. 

Two disadvantages of Moving Range charts are: 

• A lag effect due to sample measurements derived from n-1 previous measurements. 

• Oscillatory effects that occur due to successive samples having correlated random error. 

Sample size cannot be less than 2 in Moving Average charts. 
 

Exponentially Weighted Moving Average (EWMA) Chart 
An EWMA chart is an exponentially "smoothed" moving average used for evaluating the 
stability of a process. The term “exponentially” refers to the method that is employed to 
average earlier data with current data. 

A Lambda (page 19) factor is used to associate a weight with each new data point, compared 
to the remaining data points in the designated sample size. This exponential weighting is 
applied to each data point, whether individual observations or subgroup averages, and has the 
effect of reducing the contribution of older data through progressively smaller weights. 

The EWMA chart can be used in place of a Moving Average chart to place more emphasis on 
current data values. Placing more emphasis on current data makes the EWMA chart more 
sensitive to small process trends and less sensitive to sudden process spikes. 

Note: The Lambda weighting factor is typically between 0.2 and 0.5, with a default value 
of 0.5. 

 

Standard Deviation (s) Chart 
A Standard Deviation chart calculates and plots a sample standard deviation for each sample 
subgroup. A Standard Deviation chart serves the same purpose as the Range chart, but should 
be used when the sample size is greater than 8.  

Note: Sample size must be greater than 1, and preferably equal to or greater than 10, 
the default sample size. 
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Moving Standard Deviation Chart 
A Moving Standard Deviation chart utilizes the latest n observations to judge the stability of 
the process. The current sample standard deviation is calculated by replacing the oldest value 
in the sample with the current value. 

Moving Standard Deviation charts are used instead of Moving Range charts when the sample 
subgroup size is greater than 8. As with Moving Average charts, the effect of combining 
successive data points causes correlated contributions of random error and results in an 
oscillatory effect when plotted. 

 

Range (R) Chart 
A Range chart calculates the range (maximum - minimum) within each sample to determine 
the stability of a process. Calculated ranges are used to estimate process variability due to 
chance causes over short time spans. 

For example, a valve linkage in need of repair does not move the same way each time it is 
told to move. This inconsistency in valve action affects the product differently at different 
times, and might be examined through a Range chart. 

A Range chart is always evaluated in conjunction with either an Individuals chart or an 
Average chart. Sigma (page 7) values may be interpreted differently for range charts. 

Note: Range charts are not recommended for sample sizes larger than 8, and require a 
sample size greater than 1, with a sample size of 2 as the default value. 

 

Moving Range (Rm) Chart 
A Moving Range chart uses the latest n observations to judge the stability of the process. The 
current range is calculated by replacing the oldest value in the sample with the current value.  

As with Moving Average charts, the effect of combining successive data points causes 
correlated contributions of random error and results in an oscillatory effect when plotted.  
Sigma (page 7) values may also be interpreted differently for range charts. 

Note: Moving Range charts are not recommended for sample sizes larger than 8. 

 

Chart Tag 

Enter the name of the source tag to plot in the chart. The Chart Tag specifies the process 
data being plotted. Tag names or data sets that define PI SQC limits or parameters are defined 
on another tab. 

You can enter this tag manually or select the tag from PI through a Tag Search. Tag names 
returned from a Tag Search appear with an appended server name (\\server\tagname) 
in the Chart Tag box. 
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Note: The Chart Tag field must be filled before you can switch to another tab. 

The Chart Tag field is also used for PI SQC-RT (page 3) Alarm tags, which are configured 
at the PI server level (where the point class is SQC_Alarm). Click Alarm Tag Attributes to 
view the attributes of an Alarm tag. 

The query that retrieves Chart Tag (page 14) values also retrieves the point attributes shown 
below: 

Point Attribute Name Usage 

Descriptor Displayed in the Legend 

Point Type Used in calculations not displayed 

Zero May be used as lower plot limit 

Span Defines data range as vertical scale 

Starting digital state Digital zero  

Number of digital states Number of possible digital states minus one. 

Engineering units Displayed in the Legend 
  

Tag Search 

A PI tag search allows you to search all connected PI Servers for tags meeting a given a set of 
criteria, such as one ore more tag attribute values.  

• Click Tag Search to search a PI Server for tags using the Tag Search dialog. 

You can select tags from a Search Results list. The first tag selected is added to the Chart 
Tag field with server name will be included. 

PI SQC uses ODBC data sets and custom placeholders in the same manner as PI ProcessBook 
trends. You can use an alias or property value, or a dataset in place of a tag. 

• Click the adjacent arrow button and choose a PI Calculation or ODBC Data Set from the 
menu to search other data sources using a corresponding Data dialog.  

If an ODBC Data Set is selected then the SQL query must contain the time placeholders 
"Start Time" and "End Time" in the ODBC dataset to return the time frame specified in 
the SQC chart definition. 

If a dataset includes default placeholders, you can click Custom Placeholders to supply 
values for variables used in the ODBC query. 

• Choose Module Context to select aliases or properties via a module context defined in a 
PI Module Database. 

 

Scale 

Use Scale group fields to set the minimum and maximum for the chart's two vertical scales. 
Scales are based either on data values, explicit limits, or standard deviation calculations. The 
center line (or target) is the mean value of the plot data. 
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The following scale options are available: 

• AutoRange (the default), which automatically sets chart limits at even numbers near the 
minimum and the maximum of plotted values. 

• Database (for PI tags only), which uses the zero and span attributes of the PI SQC tag 
plotted.  

Zero and span are parameters configured in PI and cannot be changed locally. 

• Center Line +/- X Engineering Units 

• Center Line +/- N Sigma 

• Center Line +/- 3 Sigma 

• Center Line +/- 4 Sigma 

• Center Line +/- 5 Sigma 

• USL/LSL, which uses upper and lower specification limits. 

• Absolute Eng. Units, which allows manual entry of maximum and minimum scale 
values. 

 

Plot Time 

The plot time refers to the range of time over which the data is plotted and SQC calculations 
are assessed.  

Several Start Time options are available: 

• Standard PI time relative expressions, measuring time in multiples of hours and days 
from the present time, *. 

• Samples Before End Time allows you to specify a number of samples previous to the 
End Time, using a field that appears below the Start Time field when this option is 
selected. Select or input an integer for the number of samples. The default value is 20. 

In Run Mode, a PI SQC chart pans across values by the number of samples defined when 
stepping forward or backward through time. 

• Trigger Tag Change indicates that the start of each plot and product run is defined by 
the first data point that occurs after a specific trigger tag changes value. Use the field that 
appears below the Start Time field when this option is selected to enter a tag name, or 
click the ellipsis button next to the field to run a tag search.  

In Run Mode, the PI SQC Chart pans across values based on instances in time when the 
Trigger Tag value changes. All three parts of the chart are recalculated when the value is 
updated. 

On the control chart, the timestamp defining the left end of the horizontal scale represents 
the first value derived after the trigger tag value changes, indicating the start of a product 
run.  

The plotted point at the right end is either the last value before the current time (for real 
time data), or the last plotted value before the specified end time of the plot and product 
run. 



 Sample Tab 

  
PI SQC User Guide  17 

 

Note: The time of a trigger tag change does not equate to the start time of a sample, 
but instead determines which data point demarcates the first point of a sample 
group. The start time of the actual sample is defined on the Sample tab and 
occurs after the trigger tag change. If the time range or its display is changed, 
the new end time is used to determine the time of the previous trigger tag 
change. 

End Time is defined using standard PI time relative expressions, measuring time in multiples 
of hours and days from the present time, *.  

For charts that end at the current time, whenever a PI tag value changes or a new 
measurement is received from an ODBC data set, data is recalculated and both the control 
chart and histogram are updated. 

 

Sample Tab 

The Sample tab defines how chart tag samples are calculated.  
 

Sampling Method 

Two methods can be selected to work raw data into packets for calculating samples: 

Event-based sampling 
Event-based sampling is depends on a sample size n, where every n raw data points are 
combined in a statistical calculation to produce a single sample.  

For moving-window event-based calculations, a sample is produced from the raw data array, 
R, by using Ri through R(n+i). 

Time-based Sampling 
Time-based sampling is used only for PI data. This method organizes data into calculation 
packets by working with four parameters: 

Parameter Definition 

Start Time (page 
19) 

This time stamp adjusts the start time of the samples. 

Calculation Period 
(page 19) 

Duration of time between the start of sampling periods. 

Sample Period 
(page 19) 

Time between samples within sample group. 

Sample Size 
(page 18) 

The count of raw data points used in the sample calculation 

Sampling begins at the Start Time and continues with samples calculated every Calculation 
Period. Within a Calculation Period, the first n samples spaced evenly by the Sample Period 
are used for calculation. 
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For an EWMA (page 13) chart, a sample is produced for the first calculation period (the 
window), then the window is moved forward one sample period in time, and the next 
calculation made. 

Note:  An ODBC data set without a time column does not display a time stamp on the 
horizontal axis of a control chart. 

 

Calculation Basis 

Calculation Basis options define the mathematical parameters used for sampling. 

• A Time-based calculation uses samples for every Sample Period and performs a 
calculation for every Calculation Period, determined whenever samples matching the 
Sample Size are collected.  

• An Event-based calculation uses every raw data value associated with the tag. For event-
based calculations, Calculation Period, Sample Period, and Start Time of Sample are 
disabled. 

Note: Calculation Basis information is not available for PISQC-RT Alarm Tags.   

Check Settings 
Click Check Settings to test time settings for Time-based samples and ensure the minimum 
sample size once you have specified all the necessary parameters for your calculation basis. 

 

Sample Size 
The Sample Size is the number of measurements grouped into one sample.  

Samples should be chosen such that each sample encompasses all the random variation 
inherent in the process. A sampling scheme that meets this criterion is said to produce 
rational subgroups. Provided samples are aligned with rational subgroups, the smaller the 
sample size, the more sensitive calculations are to process changes.  

For new charts, the minimum sample size is the default size. The following minimum and 
recommended maximum values apply to sampling: 

Chart Type Default/ 
Minimum 

Recommended 
Maximum 

Individual 1 -- 

X-bar or Average 2 -- 

Moving Average 2 -- 

EWMA 1 -- 

Range 2 8 

Moving Range 2 8 

Standard Deviation 8 -- 
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Chart Type Default/ 
Minimum 

Recommended 
Maximum 

Moving Std. Deviation 8 -- 
  

Calculation Period 
For Time-based calculations, the Calculation Period is the time interval between the start of 
sample groups. The time period must be entered in the form: 

hh:mm:ss 

where hh is hours, mm is minutes, and ss is seconds. 

Calculation Period is ignored for Event-based calculations. 
 

Sample Period 
For Time-based calculations, the Sample Period is the time between samples within a 
sample group. The product of the Sample Period and the Sample Size should be less than or 
equal to the Calculation Period. 

For example, if the Calculation Period is 2 hours, the Sample Period is 10 minutes, and the 
Sample Size is 5, the sample groups would begin at midnight, 2:00, 4:00, and so on. The 
samples for the midnight sample group would be at 12:00, 12:10, 12:20, 12:30, and 12:40. 
The samples for the next group would be at 2:00, 2:10, 2:20, 2:30, and 2:40. 

 

Start Time of Sample 
Use Start Time of Sample to adjust the start time of a sample within a day. If the 
Calculation Period is greater than one day, the Start Time is used for the day on which the 
calculation is started. The derived values are calculated and stored at the time of the last 
sample within the Calculation Period. 

For example, if the Calculation Period is 2 hours, the Sample Period is 10 minutes, the 
Sample Size  is 5, and the Start Time is 3 a.m., then sample groups begin at 3 a.m., 5.a.m., 
and so forth. Samples for the first sample group would be taken at 3:00, 3:10, 3:20, 3:30, and 
3:40.  

 

Time Stamp at 
Specify the raw data point to use in determining a timestamp for each calculated point. This 
feature is useful when the Sample Size is larger than 1. 

For example, if the sample size is 5 and Time stamp at is set to 3, the time at which every 
third raw data point is collected is used as the timestamp for the related calculated point. 

 

Lambda 
Lambda associates a weight with each new data point as compared with the remaining data 
points in the designated sample. The Lambda factor pertains only to EWMA (page 13) 
(Exponentially Weighted Moving Average) charts, and does not appear for other types. 
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Lambda must be between 0 and 1.  A smaller value of Lambda provides greater smoothing 
effects and the resulting chart will emphasize trends as opposed to point-to-point fluctuations. 
The default value for Lambda is 0.5, with values between 0.2 and 0.5 most typical. 

 

Filter Equations 

Filter Equations can be used to filter data from samples. In a filter equation, 0 equals 
FALSE and 1 equals TRUE. Only data representative of time periods when the Filter 
Equation is TRUE are included in samples and used in PI SQC calculations. 

Note: Filter equations can include PI tags, but not ODBC data sets. However, you can 
filter ODBC data using the WHERE clause of the ODBC query. 

Use the following tools to build a filter equation in the Filter Equation field: 

• Click Tag Search to locate PI tags and append the selected result to the equation in the 
Filter Equation box. For multiple selected items, only the first is added. 

PI tags used in a filter equation must exist on the same PI server as the Chart Tag (page 
14). 

• Click Check Syntax to send the equation to the PI server to validate syntax (page 20). A 
dialog box indicates any errors in the equation syntax.  

The contents of the Filter Equation field are also validated whenever you exit the 
Sample tab.  

• Clear the Keep Bad Values checkbox to omit bad data values (page 21) from samples 
and from control limit calculations.  

 

Filter Equation Syntax 
Filter equations use PI Performance Equation syntax and may include: 

• operands 

• arithmetic operators 

• built-in functions 

• user-defined formulas 

• if-then -else structures 

• PI tag values 

Filters may cause large time gaps in data. To avoid gaps you may choose to keep bad values 
(page 21).  

Note: When defining a filter equation, use PI tags with the step attribute set to TRUE. 
Interpolation of tag values in the filter expression might otherwise provide a 
misleading visualization.  
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Keep Bad Values 
The number of plot markers in a time series is the number of good values divided by sample 
size. If they do not divide evenly, the remainder is ignored. For example, given a sample size 
of 10 and 99 good values, a plot will have 9 points. 

You may choose to keep bad values in control charts, allowing PI tag values with invalid 
status to be included in sample groups (but not in calculations). In such cases, the chart is 
calculated using only the remaining good values.  

If bad values are kept, they are counted when creating sample subgroups for averages, ranges, 
and so forth. The number of markers is then the total number of values (good and bad) 
divided by the sample size, with any remainder ignored. 

If bad values are not kept, but rather omitted from the time series of values, all samples are 
the same size. 

For example, if Keep Bad Values is checked, and if the sample size is 5 and if a group of 5 
data points includes one bad point, only 4 values will be used for the calculation for this 
particular plot point.  

PI values that fail the criteria are plotted with a black dot on the Shewhart chart.  If a 
consecutive group of values fail the filter criteria, only the first PI value to fail is plotted; 
repeated consecutive failures are omitted from the sample. 

An entire sample calculation is determined to be bad, and is not plotted, whenever the number 
of good values is less than 50% of the specified sample size. The Range and Moving Range 
calculations are exceptions in that they require only 2 good values in a sample subgroup. 

Note: For EWMA charts, a bad value resets the calculation. If EWMAt is bad, EWMAt+1 = 
xt+1. 

 

Control Parameters Tab 

Control parameters are process limits, which may either be process specifications or control 
limits.  

• Process specifications are fixed, "not to exceed" limits applied to a product and based on 
market, safety, or engineering limits.  

• Control limits are calculated from measurements sampled during a controlled process 
operation, or from the actual data of the current process. 

Note: For PI SQC-RT Alarm Tags, control limits are read-only. Refer to the PI SQC-RT 
User Guide for information on remote calculation of control limits in PI. 

All PI SQC control limits used to define control chart zones (page 6) are accessible through 
the Control Parameters tab. You can select constants, PI tags, or ODBC data sets to define 
limits for each parameter: 

• Enter constant values directly in Control Limit fields. 
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If constants are used, then the control limits do not change unless the user returns to the 
Control Parameters tab and manually changes them. 

• Click Tag Search to use the Tag Search dialog to find and select PI tags. Corresponding 
tag values are used as control limits.  

• Click the arrow button adjacent to Tag Search and select PI Calculation or ODBC to 
display a corresponding Data dialog. Then choose a dataset that contains the desired 
control limit values.  

If an ODBC data set is used for limits, you must specify Start and End Times under Plot 
Time (page 16). The PI ProcessBook User Guide includes information on how to create a 
new ODBC data set.  

• Click the arrow button and select Element Context to select an AF Element as a control 
limit.  

Note: this option only appears if you use PI SQC with PI ProcessBook 3.2 or higher. 

• Click one of the Sigma Calculation Method options:  
ο Average Range Estimate  
ο Average Standard Deviation Estimate  

When a new SQC symbol is created through the user interface or automation, the default 
values of the Sigma Calculation Method vary according to the plot type. The plot type 
also determines if the Sigma Calculation Method option buttons are disabled or non-
modifiable through automation. These buttons are also disabled for server side alarms, 
regardless of plot type. 

You may also let PI SQC calculate limits based on the data in the plot: 

• If you do not specify a Center Line value, PI SQC uses the mean of the plot data as the 
center line. 

• If you do not specify any control limit parameters, PI SQC calculates limits based on a 
Sigma value, determined by the distribution of data. 

 

Data Filter Tab 

Data filters allow removal of data that do not represent a nominal process. Data that do not 
meet the specified criteria are discarded, and standard deviation, process capability, mean, 
and all other statistical calculations are then made with the remaining data.  

Statistical calculations are generally computed at the end of the defined time period governed 
by a trigger tag (page 16). The defined time period is always the time period between the left 
and right axis of the chart.  

Note: For PI SQC-RT Alarm Tags, Data Filter information is not available. 
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Sigma Calculation Data Filter 

A Sigma Calculation Data Filter provides logic that determines how the system analyzes 
and discards data prior to performing statistical calculations.  

• Enter a Minimum data points value to specify the threshold required for a valid Sigma 
calculation. 

This value is required, and should depend on the sample size and the particular operating 
environment. The default is 10 and the value must be an integer. 

• When selected, the Eliminate samples option eliminates data outside of a specified 
number, n Sigma.  

Generally, n is set to a value between 4 and 7. The default is 5, and n must be an integer 
greater than one. 

 

Transition Data Filter 

The Transition Data Filter allows you configure the trigger tag to specify when calculations 
should begin after a new trigger tag event occurs. The complete configuration sentence (with 
default values) reads, 

After trigger tag event, begin calculating when 5 consecutive 
samples within 3 Sigma of each other are reported. 

Four variables in the filter statement are configurable: 

• Number of samples (default is 5) 

• Consecutive or non-consecutive samples 

• Range by which two data points can be separated before calculation resumes (default is 
3 Sigma)  

• Variability around either the center line or between samples, to indicate the relationship 
data points must share (default is Each Other, indicating relationship between 
samples)  

You may also force the system to ignore the filter statement entirely by setting the number of 
samples variable to 1. 

Use the check boxes to specify if the Transition Data Filter should apply to Sigma 
calculations, to alarm calculations, or to both. 

 

Alarm Tab 

The Alarm tab provides tools to define pattern tests (page 24) for unnatural data variation, 
and to indicate process points that are out of statistical control. PI SQC applies pattern tests 
and calculates an alarm state for each sample. Points out of statistical control can be 
configured to display with specific symbols and colors in the control chart. 
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Note: For PI SQC-RT Alarm tags, Alarm tab settings are read-only (except alarm marker 
type and alarm marker color). 

The Alarm tab includes criteria and settings for seven SQC pattern tests, in order of highest 
precedence: 

• Outside Control –  A count of the number of data points outside the control limit on one 
side of the centerline. 

• Outside Two Sigma – A count of the number of data points outside a limit drawn two-
thirds of the distance between the centerline and a control limit. 

• Outside One Sigma – A count of the number of data points outside a limit drawn one-
third of the distance between the centerline and a control limit. 

• One Side of Centerline – A count of the number of data points on one side of the 
centerline. 

• Stratification – A count of the number of data points that fall within the upper and lower 
one sigma limits on both sides of the center line 

• Mixture – A count of the number of data points that fall outside the upper and lower one 
sigma limits on both sides of the center line. 

• Trend – A count of the number of data points, which are monotonically increasing or 
decreasing. 

To configure pattern tests: 

• Click the checkbox at left to enable a test. 

• Click the marker symbol in the next column and choose Marker to reset the marker 
shape, or Color to reset the marker color through the Windows color palette.  

The marker format appears against zone backgrounds set on the Format tab (page 25). 

• Enter values to describe the test conditions in the two entry fields to complete the test test 
condition. 

Alarm Reset 

You may also specify an Alarm Reset tag by clicking the ellipsis button and using the Tag 
Search dialog to select a PI tag. When the specified tag reaches zero, alarm calculations are 
stopped.  

When the Alarm Reset tag is no longer zero, alarm calculations restart. If no reset tag is 
specified, alarms are always on by default. 

 

Pattern Tests 

Alarm pattern tests compare derived values to control limit lines, center line and intermediate 
values. The simplest pattern is a test for a single value outside of control limits. 

Control charts are more sensitive to process changes when more complicated tests are used. 
Such tests use a sequence of values to test for patterns that are unlikely in a normal 
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distribution. For example, an out-of- control condition for charts may be when 2 out of 3 
consecutive values are outside of 2 Sigma. 

Default settings for pattern tests are based on recommendations from the Statistical Quality 
Control Handbook; Western Electric Co., Inc.; 1956; Indianapolis, Indiana, on  pages 23-30, 
under "Tests for Unnatural Patterns." 

 

Format Tab 

The Format tab provides tools used to modify the appearance of SQC charts. As you make 
changes in the Format tab, the sample chart at the lower right of the tab changes to preview 
your selections. 

Chart Element 

Select an element and use the accompanying options to specify Line Style and Width, Data 
Markers and their Size, and the Color of the selected element: 

• Center Zone - 0-1 Sigma above or below the center line 

• One Sigma Zone - between 1-2 Sigma above or below the center line 

• Two Sigma Zone - between 2-3 Sigma above or below the center line 

• Outside 3 Sigma Zone - 3 Sigma above or below the center line 

• Text - on all parts of the chart. The font size and font style are configurable using the PI 
ProcessBook font toolbar button. 

• Background - color of the chart background 

• Control Chart Data - pen color and line style for the curve plotted on the control chart 

• Specification Limits - pen color and line style for USL/LSL 

• Histogram Bars - color of histogram bars 

• Histogram Distribution - pen color and line style for the curve plotted on the Histogram 

• Marker - shape and color of the data markers that are not in alarm. A value of None 
causes all markers to disappear. 

• Histogram Specs -  pen color and line style for specification lines on the histogram 

• Histogram Mean - pen color and line style for the mean on the histogram 

• Control Limits - pen color and line style for the UCL and LCL on the control chart  

Chart Options 

The check boxes in the Chart Options group designate whether or not to display the 
following items in the PI SQC chart: 

• Chart Title 

• Histogram  

• Legend  

• Control Chart  
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• Control Limit Scale 

• Plot Limits Stepwise  

Legend 

The Legend group check boxes designate whether or not to display the following items in the 
chart legend: 

• Chart Tag - the name of the chart tag (page 14) 

• Trigger Tag - the name of the trigger tag (page 16), if used  

• Eng. Units - the engineering units associated with the chart tag 

• USL/LSL - upper and lower specification limits 

• Value - the current value of the chart tag  

• Sigma - the sigma value of control limits 

• Cpk - the Cpk (see "Process Capability Index (Cpk)" on page 40), based on the current 
plot  

Zone Colors 

Zone color samples appear at the upper right of the tab, below shape and color samples of 
data markers used for points in alarm (as defined on the Alarm tab (page 23)).  

Zone colors are set with other Chart Element controls, but you can make final adjustments to 
alarm markers using the data marker buttons.  

Histogram Bars 

Defines the number of bars to be included in the histogram (page 8). 

Save as Default 

To retain your format settings as the default formatting for future charts, click the Save as 
Default button below the Chart Options. The settings are stored in the Procbook.ini file 
until they are saved again. 
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These general conventions apply to statistical calculations:  

• For PI tags, data precision is set to a tag’s display precision property in PI. For ODBC 
data sets, precision is set to 5 significant figures. 

• If a center line is not specified for a chart, the grand average of data is used instead. 

• Either a constant or PI tag may be specified as a control limit. If control limits are not 
specified, theoretical control limits are calculated from available data using the 
ANSI/ASQC standard A1-1987.  

• Control limits are calculated separately to allow control limit bands of different heights.  

The statistical analysis methods used by PI SQC are based on concepts and equations from 
Essentials of SPC in the Process Industries by James M. Pruett and Helmut Schneider, 
Second printing, February 1996, and the ANSI/ASQC standard A1-1987. 

 

Control Chart Calculations 

The following sections detail the calculations used in plotting PI SQC control charts. 
Statistical formulas presented in this section refer to constants (page 36) and symbols (page 
39) described in corresponding topics. 

 

Individuals Calculations 

Sample Average 

The sample average value is calculated using the equation: 

 
where: 
 Xi  are individual measurements 

 n is the number of measurements 

Control Limits 

Appendix A 

Statistical Calculation Basis 
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The three sigma control limits for Individuals charts are: 

 

 
where: 

UCL is the Upper Control Limit 

LCL is the Lower Control Limit 

 is the sample average as calculated previously 

σ is the process standard deviation, also known as sigma 

The process standard deviation is estimated using one of two approaches: 

• Average Range Estimation method–- Calculate an estimate of the process standard 
deviation based on the average of moving ranges. 

• Average Standard Deviation Estimation method–- Calculate an estimate of the process 
standard deviation based on the average of moving standard deviations. 

Sigma Calculation—Average Range Method 

Using this method the process sigma is derived as follows: 

 

          
where the constants d2 and E2 = 3/d2 are 1.128 and 2.660, respectively, for two-period 
moving range calculations.  

The two-period average moving range is calculated as: 

 
where 2-period moving ranges are: 

  
with n, the sample size and Xk , the individual measurements. 

Sigma Calculation—Average Standard Deviation Method 

The sample standard deviation σ, is calculated from individual measurements as: 
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where the constants c4 and E3 =3/c4 are .8862 and 3.385, respectively, for 3-period moving 
standard deviation calculations.  

The average 3-period moving standard deviation is calculated as 

 
where 3-period moving standard deviations are: 

 
where the average for the 3-period moving subgroup k is: 

 
with n, the sample size and Xi, the individual measurements. 

 

X-Bar Calculations 

Sample Average 

Sample averages are calculated as: 

, for consecutive samples k = 1 to g. 

where  

 are individual measurements (ith measurement of consecutive sample k) 

g is the number of samples (subgroups) 

n is the sample size (size of each sample) 

Center Line 

The Center Line is the grand average of the sample averages: 

  
Control Limits 
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The Upper and Lower Control Limits are calculated as: 

 

 
Sigma Calculation—Average Range Method 

The estimate of the process standard deviation, sigma, is calculated using the average of 
sample ranges: 

 

             
where A2 is listed in the Factors for Averages (page 36) table for various sample sizes n. 

Average Range 

The Average Range calculated as: 

 
where sample ranges are: 

 
with i = 1 to n in each consecutive sample k = 1 to g. 

Sigma Calculation—Average Standard Deviation Method 

The estimate of the process standard deviation, sigma, is calculated using the average of 
standard deviation as:  

 
where A3 is listed in the Factors for Averages (page 36) table for various sample sizes n. 

Average Standard Deviation 

The Average Standard Deviation is calculated as: 

 
where sample standard deviations are: 



 Control Chart Calculations 

  
PI SQC User Guide  31 

 

 for each sample k=1 to g 

with sample averages as calculated previously. 
 

Moving Average Calculations 

Sample Averages 

Sample averages are calculated as: 

 for each moving sample k = 1 to g 

where: 

Xk+i-1 are individual measurements (ith measurement of moving sample k) 

g is the number of samples (subgroups) 

n is the sample size (size of each sample) 

Center Line 

The Center Line is the average of sample averages:  

 
Control Limits 

The Upper and Lower Control Limits are calculated as shown below: 

 

 
Sigma Calculation—Average Range Method 

The estimate of the process standard deviation, sigma, is calculated using the average of 
sample ranges:  

 

             
where A2 is listed in the Factors for Averages (page 36) table for various sample sizes n. 
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Average Range 

The Average Range is calculated as: 

 
where sample ranges are: 

 =  with i = 1 to n in each moving sample k = 1 to g. 

Sigma Calculation—Average Standard Deviation Method 

 The estimate of the process standard deviation, sigma, is calculated using the average of 
standard deviations as: 

 
where A3 is listed in the Factors for Averages (page 36) table for various sample sizes n. 

Average Standard Deviation 

The Average Standard Deviation is calculated as: 

 
where sample standard deviations are: 

 for each sample k=1 to g 

with sample averages as calculated previously. 
 

Exponentially Weighted Moving Average (EWMA) Calculations 

Sample Averages 

The averages for consecutive samples are: 

, for samples k = 1 to g. 

where: 

 are individual measurements (ith measurement of consecutive sample k) 

g is the number of samples (subgroups) 

n is the sample Size (size of each sample) 
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If the sample size is 1, sample averages  are individual measurements  

Transformation of individual observations 

The consecutive sample averages are transformed into a series of weighted averages: 

 for k = 1 to g 

with 

 
where λ is the weighting factor. 

Center Line 

The Center Line is the average of the transformed data and calculated as: 

  
Control Limits 

The equations needed for calculating the upper and lower Control Limits are similar to as 
those used for the Individuals charts except that they take into account the weighting factor λ. 

 

 
Sigma Calculation—Average Moving Range Method 

 

 
where: 

 
Because EWMA involves two-period calculations, d2 = 1.128, E2 = 2.66 and for various 
values of λ, L is calculated as: 

 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 

 L 0.610 0.887 1.117 1.330 1.536 1.741 1.952 2.172 2.175 

Average Range 
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The Average Range is calculated as: 

 
where sample ranges are: 

 =  with i = 1 to n in each moving sample k = 1 to g. 
 

Range Calculations 

Sample Ranges 

The ranges of individual samples are: 

 =  for i = 1 to n in each sample k = 1 to g. 

Center Line 

The Center Line is calculated from sample ranges as: 

 
Control Limits 

Upper Control Limit: 

    
Lower Control Limit: 

 

The constants  and   are listed in the Factors for Ranges (page 37) table for various 
sample sizes n. 

 

Moving Range Calculations 

Sample Ranges 

The ranges of individual samples are: 

 =  with i = 1 to n in each moving sample k = 1 to g. 

Center Line 

The Center Line is calculated from sample ranges as: 
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Control Limits 

See Range Calculations (page 34) for upper and lower control limits. 
 

Standard Deviation Calculations 

Sample Standard Deviations 

The standard deviations of individual samples are calculated as:  

 in each sample k = 1 to g 

where: 

 are individual measurements, for i = 1 to n 

g is the number of samples (subgroups) 

n is the sample size (size of each sample) 

Sample averages, , are calculated as: 

 , for consecutive samples k = 1 to g. 

Center Line 

The Center Line is the Average Standard Deviation which is calculated from sample standard 
deviations as: 

 
Control Limits 

Upper Control Limit: 

 
Lower Control Limit: 

 

 and  are listed in the Factors for Standard Deviations (page 38) table for various 
sample sizes n. 
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Moving Standard Deviation Calculations 

Sample Standard Deviations 

The standard deviations of individual samples are calculated as:  

 for each sample k=1 to g 

where: 

 are individual measurement, i = 1 to n 

g is the number of samples (subgroups) 

n is the sample size (size of each sample) 

Sample averages, , are calculated as: 

 , for consecutive samples k = 1 to g. 

Center Line 

The Center Line is the Average Standard Deviation, which is calculated from sample 
standard deviations as: 

 
Control Limits 

See Standard Deviation Calculations (page 35) for upper and lower control limits. 
 

Factors 

The following sections detail factors used in control chart calculations. In all tables, n is the 
sample size. 

 

Factors for Averages 

Observations in Sample, n 

n A2 A3 

2 1.880 2.659 

3 1.023 1.954 

4 0.729 1.628 
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n A2 A3 

5 0.577 1.427 

6 0.483 1.287 

7 0.419 1.182 

8 0.373 1.099 

9 0.337 1.032 

10 0.308 0.975 

11 0.285 0.927 

12 0.266 0.886 

13 0.249 0.850 

14 0.235 0.817 

15 0.223 0.789 

16 0.212 0.763 

17 0.203 0.739 

18 0.194 0.718 

19 0.187 0.698 

20 0.180 0.680 

21 0.173 0.663 

22 0.167 0.647 

23 0.162 0.633 

24 0.157 0.619 

25 0.153 0.606 

 
 

Factors for Ranges 

Observations in Sample n 

n d2 D1 D2 D3 D4 

2 1.128 0 3.686 0 3.267 

3 1.693 0 4.358 0 2.574 

4 2.059 0 4.698 0 2.282 

5 2.326 0 4.918 0 2.114 

6 2.534 0 5.078 0 2.004 

7 2.704 0.204 5.204 0.076 1.924 

8 2.847 0.388 5.306 0.136 1.864 

9 2.970 0.547 5.393 0.184 1.816 

10 3.078 0.687 5.469 0.223 1.777 



Statistical Calculation Basis 

  
38 

   
 

n d2 D1 D2 D3 D4 

11 3.173 0.811 5.535 0.256 1.744 

12 3.258 0.922 5.594 0.283 1.717 

13 3.336 1.025 5.647 0.307 1.693 

14 3.407 1.118 5.696 0.328 1.672 

15 3.472 1.203 5.741 0.347 1.653 

16 3.532 1.282 5.782 0.363 1.637 

17 3.588 1.356 5.820 0.378 1.622 

18 3.640 1.424 5.856 0.391 1.608 

19 3.689 1.487 5.891 0.403 1.597 

20 3.735 1.549 5.921 0.415 1.585 

21 3.778 1.605 5.951 0.425 1.575 

22 3.819 1.659 5.979 0.434 1.566 

23 3.858 1.710 6.006 0.443 1.557 

24 3.895 1.759 6.031 0.451 1.548 

25 3.931 1.806 6.056 0.459 1.541 

 
 

Factors for Standard Deviations 

Observations in Sample n 

n c4 B3 B4 B5 B6 

2 0.7979 0 3.267 0 2.606 

3 0.8862 0 2.568 0 2.276 

4 0.9123 0 2.266 0 2.088 

5 0.9400 0 2.089 0 1.964 

6 0.9515 0.030 1.970 0.029 1.874 

7 0.9594 0.118 1.882 0.113 1.806 

8 0.9650 0.185 1.815 0.176 1.751 

9 0.9693 0.239 1.761 0.232 1.707 

10 0.9727 0.284 1.716 0.276 1.669 

11 0.9754 0.321 1.679 0.313 1.637 

12 0.9776 0.354 1.646 0.346 1.610 

13 0.9794 0.382 1.618 0.374 1.585 

14 0.9810 0.406 1.594 0.399 1.563 

15 0.9823 0.428 1.572 0.421 1.544 

16 0.9835 0.448 1.552 0.440 1.526 
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n c4 B3 B4 B5 B6 

17 0.9845 0.466 1.534 0.458 1.511 

18 0.9854 0.482 1.518 0.475 1.496 

19 0.9862 0.497 1.503 0.490 1.483 

20 0.9869 0.510 1.490 0.504 1.470 

21 0.9876 0.523 1.477 0.516 1.459 

22 0.9882 0.534 1.466 0.528 1.448 

23 0.9887 0.545 1.455 0.539 1.438 

24 0.9892 0.555 1.445 0.549 1.429 

25 0.9896 0.565 1.435 0.559 1.420 

 
 

Mathematical Symbols 

The following mathematical symbols are used in calculations. 

M = Number of Samples 

n = Number of measurements in a Sample 

g =Number of samples 

 = Sample Range 

 = Average Range 

 = Average Moving Range 

 = Sample standard deviation 

 = Average sample standard deviation 

Xmax = Maximum measurement within a sample 

Xmin   = Minimum measurement within a sample 

 = Individual Observation 

 = Sample Average 

 = Average of Samples 

 = Grand Average of Samples 
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  = Weighting Factor for EWMA charts 
 

Process Capability Index (Cpk) 

The Process Capability Index (Cpk) or "process potential" refers to the ability of a process to 
produce products that meet customer specifications.  

The larger the Cpk number, the more likely a process is capable of producing product within 
specifications. 

Cpk is calculated as follows: 

Upper and lower control limits are assumed to be different. One-sided capability indexes are 
determined by: 

 Cpu = (USL - µ)/3σ 

 Cpl = (µ - LSL)/3σ 

where: 

 µ is process mean 

 σ is process standard deviation 

Then the Cpk capability index is determined by: 

 Cpk = Min(Cpu, Cpl) 

If, in the rare case the standard deviation is zero, the process capability index cannot be 
calculated and the Cpk is set to N/A. 
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Fluctuating Measurements 
All processes have parameters that can be measured. Repeated measurement of a process's 
parameters will show fluctuations in the parameter's value. Fluctuations can be classified as 
natural or unnatural. 

Natural Pattern 
A pattern of measurements of a process parameter exhibiting natural variability due to minute 
fluctuations in raw materials, equipment, measurement precision, etc. Obviously, natural 
fluctuations result in natural patterns. A natural pattern will always have the all of the 
following characteristics: 

1. Most of the points are near the Center Line. 

2. A few of the points spread out and approach the Control Limits 

None (or at least only a very rare point) exceeds the Control Limits. 

Process 
A process is a set of conditions or causes that work together to produce a result. In an 
industrial setting a process can be a single control loop, a unit operation, a laboratory 
measurement, a task performed by a single person or a team, or virtually any combination of 
'actors' which work together to produce a result. 

Sample Grouping 
Breaking a large collection of measurements into subgroups. Evaluating sample averages and 
ranges provides a more sensitive tool for spotting process variations with definable causes 
(unnatural patterns). 

Tests for Unnatural Patterns 
There are two basic premises for testing the naturalness of a pattern: 

ο Test individual points versus limits 
ο Test multiple points for trend - there are several commonly accepted tests for trend 

recognition (e.g. 8 points in a row on one side of the plot center line) 

Unnatural patterns indicate possible process variations with definable causes. 

Appendix B 

Glossary 
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Unnatural Fluctuation 
These are large, abnormal fluctuations due to some external cause. The causes of unnatural 
fluctuations are generally definable to some outside influence. For example, an unnatural 
fluctuation could arise from software malfunction, field instrument failure, putting the wrong 
material into the product or similar causes. 

Unnatural Pattern 
A pattern of measurements of a process parameter exhibiting large fluctuations due to a 
definable cause. An unnatural pattern will lack one or more of the three characteristics of a 
natural pattern. 
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You can read complete information about technical support options, and access all of the 
following resources at the OSIsoft Technical Support Web site: 

http://techsupport.osisoft.com (http://techsupport.osisoft.com) 

Before You Call or Write for Help 

When you contact OSIsoft Technical Support, please provide: 

• Product name, version, and/or build numbers 

• Computer platform (CPU type, operating system, and version number) 

• The time that the difficulty started 

• The message log(s) at that time 

Help Desk and Telephone Support 

You can contact OSIsoft Technical Support 24 hours a day. Use the numbers in the table 
below to find the most appropriate number for your area.  Dialing any of these numbers will 
route your call into our global support queue to be answered by engineers stationed around 
the world. 

Office Location Access Number Local Language Options 

San Leandro, CA, USA 1 510 297 5828 English 

Philadelphia, PA, USA 1 215 606 0705 English 

Johnson City, TN, USA 1 423 610 3800 English 

Montreal, QC, Canada 1 514 493 0663 English, French 

São Paulo, Brazil 55 11 3053 5040 English, Portuguese 

Altenstadt, Germany 49 6047 9890 English, German 

Manama, Bahrain 973 1758 4429 English, Arabic 

Singapore 65 6391 1811 
86 021 2327 8686 

English, Mandarin 
Mandarin 

Perth, WA, Australia 61 8 9282 9220 English 

Appendix C 

Technical Support and Resources 

http://techsupport.osisoft.com/�
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Support may be provided in languages other than English in certain centers (listed above) 
based on availability of attendants. If you select a local language option, we will make best 
efforts to connect you with an available Technical Support Engineer (TSE) with that language 
skill. If no local language TSE is available to assist you, you will be routed to the first 
available attendant. 

If all available TSEs are busy assisting other customers when you call, you will be prompted 
to remain on the line to wait for the next available TSE or else leave a voicemail message.  If 
you choose to leave a message, you will not lose your place in the queue.  Your voicemail 
will be treated as a regular phone call and will be directed to the first TSE who becomes 
available. 

If you are calling about an ongoing case, be sure to reference your case number when you call 
so we can connect you to the engineer currently assigned to your case.  If that engineer is not 
available, another engineer will attempt to assist you.  

Search Support 

From the OSIsoft Technical Support Web site, click Search Support. 

Quickly and easily search the OSIsoft Technical Support Web site's Support Solutions, 
Documentation, and Support Bulletins using the advanced MS SharePoint search engine. 

Email-based Technical Support 

techsupport@osisoft.com 

When contacting OSIsoft Technical Support by email, it is helpful to send the following 
information:  

• Description of issue: Short description of issue, symptoms, informational or error 
messages, history of issue  

• Message logs: See documentation for your PI System for information on obtaining 
message logs pertinent to the situation. 

Online Technical Support 

From the OSIsoft Technical Support Web site, click Contact us > My Support > My Calls. 

Using OSIsoft's Online Technical Support, you can:  

• Enter a new call directly into OSIsoft's database (monitored 24 hours a day)  

• View or edit existing OSIsoft calls that you entered  

• View any of the calls entered by your organization or site, if enabled  

• See your licensed software and dates of your Service Reliance Program agreements 
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Remote Access  

From the OSIsoft Technical Support Web site, click Contact Us > Remote Support 
Options. 

OSIsoft Support Engineers may remotely access your server in order to provide hands-on 
troubleshooting and assistance. See the Remote Access page for details on the various 
methods you can use.  

On-site service  

From the OSIsoft Technical Support Web site, click Contact Us > On-site Field Service 
Visit. 

OSIsoft provides on-site service for a fee. Visit our On-site Field Service Visit page for more 
information. 

Knowledge Center 

From the OSIsoft Technical Support Web site, click Knowledge Center. 

The Knowledge Center provides a searchable library of documentation and technical data, as 
well as a special collection of resources for system managers. For these options, click 
Knowledge Center on the Technical Support Web site. 

• The Search feature allows you to search Support Solutions, Bulletins, Support Pages, 
Known Issues, Enhancements, and Documentation (including user manuals, release 
notes, and white papers). 

• System Manager Resources include tools and instructions that help you manage: Archive 
sizing, backup scripts, daily health checks, daylight savings time configuration, PI Server 
security, PI System sizing and configuration, PI trusts for Interface Nodes, and more. 

Upgrades 

From the OSIsoft Technical Support Web site, click Contact Us > Obtaining Upgrades. 

You are eligible to download or order any available version of a product for which you have 
an active Service Reliance Program (SRP), formerly known as Tech Support Agreement 
(TSA). To verify or change your SRP status, contact your Sales Representative or Technical 
Support (http://techsupport.osisoft.com/) for assistance. 

 

 

http://techsupport.osisoft.com/�
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